Reviewer’s Guide
Copyright 2007 Corel Corporation. All rights reserved.

Corel® Paint Shop Pro® Photo X2 Reviewer’s Guide

Protected by U.S. Patents 5652880; 5347620; 5767860; 6195100; 6385336; 6552725; 6657739; 6731309; 6825859; 6633305; Patents Pending.

Product specifications, pricing, packaging, technical support and information ("specifications") refer to the retail English version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL’S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, Paint Shop Pro, CorelDRAW, iGrafx, Knowledge Base, MediaOne, Painter, Picture Tubes, Thinify, WinDVD, WinZip, WordPerfect, and WordPerfect MAIL are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada, the U.S., and/or other countries.

Adobe and Photoshop are registered trademarks of Adobe Systems Incorporated in the United States and/or other countries. Carbonite is a registered trademark of Carbonite, Inc. DirectX, Microsoft, Outlook, Windows, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Imagekind is a trademark of Imagekind, Inc. Nik is a trademark of Nik Software, Inc. Snaptotes is a registered trademark of US Handbags, Inc. Zazzle is a registered trademark of Zazzle.com, Inc. in the United States and other countries. Other product, font, and company names and logos may be trademarks or registered trademarks of their respective companies.

021067
Contents

1 | Introducing Corel Paint Shop Pro Photo X2 ...............1

2 | Customer Profile ..........................................................5
   Aspiring Photographers .......................................................5
   Workplace Communicators .................................................6

3 | Top Features ................................................................7
   Process Your Photos Like the Pros ......................................7
   Discover Editing Tools You Can’t Find Anywhere Else ..........11
   Enhance Photos Using Powerful, Easy-To-Use Tools ..........16
   Create One-Of-A-Kind Photos ............................................20

4 | Summary of New or Improved Features .......................23

5 | What’s Included? ..........................................................25
   Applications ..............................................................................25
   Content .........................................................................................25
   Printed Documentation ...............................................................26
   Electronic Documentation .........................................................26
   Minimum System Requirements ..............................................26
   Recommended System Configuration ........................................26
   Additional Requirements for Selected Features ......................26

6 | Customer Support and Other Resources .......................27
Corel® Paint Shop Pro® Photo X2 is the ideal digital photography software for users who want professional-looking photos and new ways to unlock their creative potential. With the widest selection of photo-editing features — ranging from automatic tools when you need results fast or precision controls for fine-tuning — Paint Shop Pro Photo provides a depth of functionality that grows with users as their skills and knowledge advance. Downloading, viewing, sorting, and quickly processing photos is a breeze, and users can learn as they go with a variety of learning aids in the application. With version X2, award-winning Paint Shop Pro Photo continues to set the standard for easy-to-use, powerful software at an affordable price.

Paint Shop Pro Photo X2 continues to focus on photo editing, making it the ideal choice for any aspiring photographer's digital darkroom. The exciting new features in Paint Shop Pro Photo X2 include the following:

**Express Lab** — A new streamlined mode of Paint Shop Pro Photo helps users quickly view and fix dozens of photos in the time it used to take to edit just a few. Now users can crop, rotate, and fix their photos without having to open them individually.

**Graphite Interface Theme** — A new, darker theme for Paint Shop Pro Photo X2 makes photos look their absolute best while users edit them.

**HDR Photo Merge** — Users can take advantage of their camera's auto-bracketing feature and combine multiple exposures of high-contrast scenes, which are otherwise impossible to capture adequately.

**Integrated Clarify Control** — Users can achieve incredible results with HDR Photo Merge by applying automatic dodging and burning. The enhanced Black and White Film dialog box also provides a Clarify control, so users can create dynamic, high-contrast images that mimic the use of black-and-white film with a color filter on the lens.

**Makeover Tool Modes** — The suite of easy-to-use retouching tools grows in Paint Shop Pro Photo X2 to include the new Thinify™ and Eye Drop modes, which give super results, fast.
**Layer Styles** — Users can easily apply effects such as embossing, drop shadows, glows, and even reflections, which automatically update whenever the underlying layer is edited.

**Visible Watermarks** — Users can take credit for their work by adding watermarks to photos. All it takes is a few clicks before printing or uploading proof copies.

**Workflow Improvements** — Paint Shop Pro Photo X2 makes it easier to use photos in documents, presentations, and Web pages through the new Save for Office and Copy Special options, plus redesigned Resize and Save As dialog boxes.

**Auto-Preserve Originals** — Original photos are now automatically preserved when users save an edited version. This new feature provides a safety net in case users want to return to the original version.

Supporting these features is the award-winning Learning Center, which helps new users get up to speed quickly. The Learning Center is laid out in workflow order, so users can easily identify what they’d like to do with their photos. The Learning Center is truly integrated into the application, so selecting a topic automatically launches the corresponding tool.

Unlike products with limited feature sets, Paint Shop Pro Photo provides a full range of functionality, from quick, single-click adjustments to full manual controls. Many common photo-editing tasks are much easier to perform in Paint Shop Pro Photo than in comparable applications, such as Adobe® Photoshop® Elements. Examples include the following:

- **Replacing color selectively** — Change the color of any object in a photo with just one click of the Color Changer tool while preserving the shading and texture of the original object. Even changing a dark color to a light color requires just a single click, as opposed to the difficult, multistep manual process required in Adobe Photoshop Elements.

- **Correcting perspective** — Turn any lens into a tilt-swing perspective correction lens with the Perspective Correction feature. Simply line up four corners on a photo element that should be square, and double-click. Photoshop Elements requires a complex process involving multiple controls.

- **Blurring the background selectively** — Draw attention to an object of interest in a photo with the Depth of Field effect. This feature simulates the use of a low lens aperture setting.

- **Sprucing up photo subjects** — Apply tooth-whitening, slimming, suntanning, and other enhancements with a suite of Makeover tool modes.

- **Giving images an older look** — Take photos back in time by using the seven different historical effects in the Time Machine feature.

- **Removing unwanted objects in photos** — Outline an object to remove, and a background area to use to replace it, and the object is gone. This technique is particularly useful for objects that are larger than the area you
use for the replacement texture. In Photoshop Elements, this task requires cloning, which often leads to noticeable repeat patterns.

- **Removing purple fringe** — Detect and remove the colored fringe that appears along high-contrast edges in many digital camera photos by using the Purple Fringe Remover.

- **Simulating infrared film** — Simulate the ethereal effect of infrared photography. The Infrared Film effect even includes options to simulate the flare and film grain qualities of this unique film type.

- **Importing and exporting CMYK format files** — Benefit from fully supported color management, with ICC-standard color profiles, including importing and exporting CMYK format files.

- **Merging auto-bracketed images** — Take advantage of a digital camera’s auto-bracket feature to create images that retain all the detail of shadow and highlight areas in a photo.
Customer Profiles

As the use of digital cameras has increased, Paint Shop Pro Photo X2 has kept pace, giving digital photographers of all experience levels everything they need to process, edit, and enhance their work. With its unique combination of straightforward tools, advanced photo-editing features, and groundbreaking learning resources, Paint Shop Pro Photo X2 lets users create impressive results immediately.

Paint Shop Pro Photo X2 also provides the breadth and depth of professional features, so users can grow into the program as their curiosity and experience develop. These time-saving features include automatic and one-step fixes for some of the most common digital photo flaws. Instead of shackling creativity with steep learning curves and restrictive workflows, Paint Shop Pro Photo gives the user total freedom to experiment and unlock the full potential of every photograph.

Aspiring Photographers

Aspiring photographers consider photography an art form, rather than just a means of capturing events. They are serious about photography as a strong hobby or even a part-time business.

These users care about the quality of their images and about improving them through digital editing. They are often considered to be photo experts by family and friends, and they become the group photographer.

Aspiring photographers generally own advanced equipment, such as a DSLR and special lenses, and are likely to use manual controls and camera raw formats. They are prolific shooters and need tools that allow them to efficiently process large numbers of photos.

In many cases, these users are new to digital photography and want tools that are easy to learn, but they don’t want to settle for the limited toolset of a “lite edition” or “elements version” that they may later outgrow.
Workplace Communicators

Workers in a wide range of fields — from technical writers and architects to real estate agents and legal professionals — are using graphics more than ever in their day-to-day work. Images help them to communicate more effectively by overcoming language barriers and clarifying ideas that text alone can’t fully explain. These professionals use graphics to improve their company’s image and leave a lasting impression with customers and employees alike.

Paint Shop Pro Photo X2 includes a powerful image-editing toolset that’s intuitive and easy-to-learn, so office workers can start using the application immediately. Paint Shop Pro Photo X2 offers value-minded organizations affordable and flexible licensing, easy deployment, and compatibility with a wide range of graphic file formats. In addition, the application can be easily customized to suit an individual company’s needs.

For years, Paint Shop Pro has been the preferred image-editing tool of companies worldwide in industries ranging from automotive and aerospace to energy. Paint Shop Pro Photo X2 expands its appeal to multinational businesses by offering dynamic language switching, which lets users quickly and easily change the language of the application. As the corporate world becomes increasingly global and multilingual in outlook, Paint Shop Pro Photo X2 is keeping pace by offering versions in a wide variety of languages — English, German, French, Italian, Spanish, Dutch, Japanese, Swedish, Finnish, Korean, Chinese (Traditional and Simplified), Polish, Czech, and Russian.
Top Features

Paint Shop Pro Photo X2 introduces an array of innovative features to help users simplify the editing and processing of their digital photos. These new features expand the already impressive toolset contained in the previous version of the software.

Process Your Photos Like the Pros

Paint Shop Pro Photo X2 has a variety of tools and features that allow users to quickly process vast quantities of images without sacrificing quality. Whether users work in offices, in photography studios, or at home, their ability to quickly create top-notch images is critical. Paint Shop Pro Photo X2 helps users get the end results they demand with a variety of high-quality, intuitive, and time-saving tools and features.

New! Express Lab: Nothing has fueled the digital camera revolution like the ability to take large numbers of pictures without having to worry about the cost. As a result of this newfound freedom, however, users are faced with the daunting tasks of viewing, deleting, and fixing all of those downloaded photos.

The Express Lab is ideal for processing an entire folder of photos all at once — without having to sacrifice power for speed. It helps users sort through a vast quantity of images, allowing them to view and process the photos without having to open each one.

Advanced users can fine-tune photos by using a histogram and separate controls for shadows, brightness, highlights, and saturation. Less experienced users can easily refine their photos by using the Suggest Settings feature of the Smart Photo Fix tool. The Express Lab also offers a toolset that lets users easily perform many common editing tasks, such as cropping and straightening photos and removing red-eye and blemishes. Users can also assign ratings to their photos, so they can quickly find their favorites.
The Express Lab helps users quickly process large batches of photos.

**Give it a try**

**Using the Express Lab**

1. On the standard toolbar, click the **Express Lab** button.
2. In the Express Lab, click **Get Photos**.
3. Navigate to a folder containing photos you want to edit, and click **OK**.
4. On the Express Lab toolbar, click any of the following tools to edit the photo:
   - **Straighten** — rotates a crooked photo to straighten it
   - **Crop** — trims or eliminates unwanted edges of an image
   - **Smart Photo Fix** — lets users remove color cast, brighten underexposed images, darken overexposed images, and adjust saturation
   - **Makeover** — provides five modes of cosmetic fixes, such as Blemish Fixer, Toothbrush, Eye Drop, Suntan, and Thinify
   - **Clone Brush** — removes flaws and objects by painting over them with another part of the image
   - **Red Eye** — quickly corrects the red-eye effect commonly seen in photos

The Express Lab toolbar also contains buttons for deleting, viewing, rotating, and saving images.

5. To assign a rating to a photo, click the stars under the lower-right corner of the photo.

6. Click the **Next Image** or **Previous Image** buttons to scroll through the photos in the folder.

7. Click **Exit Express Lab** to close the Express Lab.
**New! Visible Watermark:** Professional photographers and hobbyists alike want to put their stamp on the photos they take and share. The Visible Watermark feature lets users add a discreet watermark to their photos to remind viewers who took the shot and to help safeguard against misuse of their images. This new feature simplifies the task of adding a logo or other graphic as a watermark, and users can choose from options such as embossing to give their photos a subtle, professional look.

![Visible Watermark](image)

**Give it a try**

**Adding Visible Watermarks**

1. First, create a graphic to use as the watermark image by clicking **File > New**.

2. On the Tools toolbar, choose the **Text tool**.

3. On the Materials palette, click the **Foreground and Stroke Properties** box, and choose a color for the text outline.

4. In the image window, click where you want to apply the text.

5. Hold down **Alt** and type **0169** to create the © symbol, and type **2007**, and click **Apply** in the Text Entry dialog box.

6. Save the file.

7. Open the image to which you want to add a watermark, and choose **Image > Watermarking > Visible Watermark**.

8. In the Visible Watermark dialog box, click the **Browse** button, and select the watermark image you created.

9. In the Placement group box, choose the **Corner** option, and choose a placement option from the drop-list.

10. In the Style group box, drag the **Size**, **Opacity**, and **Emboss** sliders to customize the look of the watermark.

You can preview the watermark in the **After** pane or by marking the **Preview on Image** check box.

11. Click **OK**.
**New & Enhanced! Auto-Preserve Originals and Save As:**

Users don’t have to worry about overwriting their original photos, thanks to the new Auto-Preserve Originals option. The first time a user saves an image, a backup copy of the original is automatically created one level deeper in the folder hierarchy. The original can easily be restored by using the Restore Original command in the File menu.

Paint Shop Pro Photo is renowned for the number of file formats users can save to. The improved Save As command helps users quickly choose the formats they use most often by listing common and recently used ones at the top of the file format list.

**New! Save for Office and Copy Special:** Preparing an image for use in documents, in presentations, or on the Web can be tricky. The Save for Office command removes the guesswork by automatically optimizing an image for its intended use, thereby avoiding problems with file size, performance, or printing.

When users copy and paste images into other applications, the new Copy Special command prepares the image based on its intended purpose. The resizing function is built in, ensuring that no unnecessary image data is added to the document.

![Image of Save for Office and Copy Special features](image)

*The new Save for Office and Copy Special commands help users optimize images for their intended destination.*

**E-mailing:** Paint Shop Pro Photo X2 lets users e-mail photos as embedded files or attachments. A preview feature lets users double-check their images before sending them and check a running count on the size of selected files.

**Color Management:** The Color Management engine lets users read and save ICC-standard color profile data in their files, which ensures that on-screen colors match printed colors. In addition, Paint Shop Pro Photo X2 supports CMYK input and output for commercial printing.
Discover Editing Tools You Can't Find Anywhere Else

Paint Shop Pro Photo X2 has a powerful toolset that can fix nearly any digital photo imperfection. If the problem stems from the quality of the image produced by the camera, a user can apply quick, easy corrections with a series of time-saving tools. If photo subjects don’t look their best, their appearance can be spruced up faster and easier than ever before.

**New & Enhanced! Makeover Tool:** Everyone wants to look their best in a photo. To that end, Paint Shop Pro Photo X2 includes a suite of Makeover tool modes that let users quickly and easily touch up the appearance of photo subjects. The professional-strength Makeover tool contains the following modes:

- **New! Thinify™ Mode** — makes photo subjects look thinner
- **New! Eye Drop Mode** — takes the red out of irritated, bloodshot eyes
- **Enhanced! Blemish Fixer Mode** — removes blemishes from photo subjects
- **Enhanced! Suntan Mode** — adds color to pale, washed-out skin
- **Toothbrush Mode** — quickly whitens discolored teeth

![Thinify](image1)

![Eye Drop](image2)

![Blemish Fixer and Toothbrush](image3)
Color Changer Tool: The Color Changer tool lets users easily change colors in their digital images. For example, users can easily change the color of an object in a photo, such as a car or a piece of clothing. Rather than simply replacing a color, the Color Changer tool detects and analyzes variations in brightness caused by shading and texture, and then it makes the necessary adjustments to the new color to produce a realistic recoloring effect.

Give it a try

Using Makeover Suite Tools

1 On the Tools toolbar, choose the **Makeover** tool.

2 On the Tool Options palette, choose the **Thinify** mode.

3 Type a value in the **Strength** control.
   Higher values compress more pixels in the horizontal axis.

4 Click the middle of a photo subject.
   The pixels compress on either side of the point you click.

5 On the Tool Options palette, choose the **Blemish Fixer** mode.
   The cursor changes to concentric circles.

6 Adjust the **Size** control to the smallest size that allows the inner circle to enclose the blemish. The outer circle is for the material used to cover the blemish.

7 Type a value in the **Strength** control.
   Values range from 1 to 100. Higher values apply more of the source material (enclosed in the outer circle) to the blemish area (enclosed in the inner circle).

8 Click directly over the blemish.

9 On the Tool Options palette, choose the **Eye Drop** mode.

10 Type a value in the **Strength** control.
   Higher values whiten more of the eye area but may spread the whitening beyond the affected area of the eye.

11 Zoom in as necessary, and then carefully click over the bloodshot portion of the eye.
Color Changer Tool

**Noise Removal:** “Noise” artifacts — small specks of color that interfere with the clarity of the image — are one of the most common problems in digital photography. Paint Shop Pro Photo X2 gives users two noise-removal options. The One Step Noise Removal command offers one-step, automatic noise removal.

The Digital Camera Noise Removal command allows users to precisely control how these same corrections are applied. This feature has been favorably compared to specialized noise-removal plug-ins that cost as much as Paint Shop Pro Photo X2!

**Perspective Correction Tool:** This longtime favorite gives users the power and versatility of an expensive tilt-correction lens. With the Perspective Correction tool, users can fix buildings, landmarks, or objects in their photos that appear in the wrong perspective or that were taken from an angle other than directly in front. Users can simply line up the four corner points with a shape that should be rectangular to adjust the entire image.
**Purple Fringe Removal:** The One Step Purple Fringe Fix command gets rid of the purple glow that sometimes appears in digital photos around edges of objects under high-contrast conditions.

Users can quickly remove purple fringe from their photos.

**Straighten Tool:** Users can easily straighten crooked images by simply specifying a line along an image feature that should be horizontal or vertical, such as the horizon or a building.

**Background Eraser Tool:** Paint Shop Pro Photo X2 lets users selectively erase pixels with the Background Eraser tool. For example, in a photo of a mountain range, users can erase the sky or isolate an object from the surrounding image area. When the background behind photo subjects is erased, fine-edged detail around hair or fur is retained.

**Object Remover:** If the only thing that stands between a good photo and a perfect one is an unwanted element — a lamppost, a tree, even a bystander — the Object Remover can help. The Object Remover makes it easy to remove unwanted or difficult-to-clone portions of images and fills in the removed detail with portions of the remaining photo. Just outline the object to remove, and a background area to use to replace it, and the object is gone.

Object Remover
**Enhanced! Crop Tool:** Users who scan multiple images at the same time will love the enhanced Crop tool. The new Crop to New Image feature automatically creates a new file from the cropped area and keeps the original full scan open, so users can easily separate individual image files from the group scan.

Users can access the Crop to New Image button on the Tool Options Palette or the floating toolbar for the Crop tool.

The Crop to New Image feature lets users quickly separate individual images from group scans.
Enhance Photos Using Powerful, Easy-To-Use Tools

Paint Shop Pro Photo is renowned for being user-friendly — that's because user feedback has always played a huge role in its development. From requesting one-click automatic fixes that take the guesswork out of image correction to insisting on advanced image-editing tools, the user has spoken, and Paint Shop Pro Photo X2 has responded. And as digital cameras have evolved, Paint Shop Pro Photo has kept pace, so that users can get as much out of their photos as their cameras offer.

**New! HDR Photo Merge:** Many digital cameras have an auto-bracket feature, which lets users take multiple shots of the same scene, each with a different exposure level. This feature is ideal for photos taken in high-contrast scenes, such as a sunset. One shot adjusts the exposure to capture the shadows, while another shot adjusts the exposure to capture bright areas. The HDR (High Dynamic Range) Photo Merge feature lets users combine auto-bracketed photos to create a photo that retains the critical detail of the images being combined. While ideal for photos shot using a tripod and auto-bracketing, this feature can automatically align images captured with handheld cameras using manual-exposure adjustments.

The HDR Photo Merge feature helps users get the most out of their digital cameras.

---

**Give it a try**

**Using HDR Photo Merge**

1. Choose File ➤ HDR Photo Merge to access the HDR Photo Merge dialog box.
2. In the Load Images group box, click the Browse button, and navigate to the folder containing the bracketed photos.
3. Select the photos you want to merge, and click Open.
4. Click Align Images.
Enhanced! Black and White Film Effect: Users can easily create dynamic black-and-white photos by simulating the effects of shooting using black-and-white film with colored filters. Paint Shop Pro Photo X2 gives users the full creative control of the Channel Mixer command by letting them select from a virtually infinite range of color combinations within an intuitive, easy-to-use interface. The enhanced Black and White Film dialog box also provides a Clarify control, so users can create dynamic, high-contrast images that mimic the use of black-and-white film with a color filter on the lens.

**Give it a try**

**Using the Black and White Film Effect**

1. Open an image file, choose Effects ➤ Photo Effects ➤ Black and White Film to access the Black and White Film dialog box.
2. In the Filter Color group box, drag in the color spectrum to set the desired RGB filter color.
3. In the Adjustments group box, drag the **Brightness** slider to adjust the converted image's overall brightness, and drag the **Clarify** slider to adjust the converted image's local contrast or “snap.”
4. Click **OK**.

Users can choose from an infinite range of color combinations.
One Step Photo Fix and Smart Photo Fix: The One Step Photo Fix command automatically applies six common photo corrections to an image. All the user needs to do is select the command.

The Smart Photo Fix analyzes a photo and suggests settings for auto-corrections of color, brightness, sharpness, and saturation used in One Step Photo Fix. Completely flexible, users can apply the suggested settings or experiment further by manually fine-tuning the settings. At any point, if users decide that they prefer the results of the initially suggested fix, they can quickly reapply the suggested settings. Paint Shop Pro Photo X2 gives users the flexibility to experiment freely with confidence, knowing that they can always revert to their starting point.

By suggesting changes to users, the Smart Photo Fix feature takes the guesswork out of getting great image results.

Depth of Field Effect: Paint Shop Pro Photo lets users draw attention to a specific area of an image. The Depth of Field effect applies focus to a region of a photo while applying an out-of-focus blur to the rest of the image. This allows users to easily replicate the look of limited depth of field, an effect that usually requires precise manual lens aperture adjustments.
Advanced Adjustments: Paint Shop Pro Photo X2 offers advanced users the professional-level tools and features that are usually found only in expensive image-editing applications. These advanced features include the following:

- **Curves and Levels Adjustments** — The Curves and Levels features in Paint Shop Pro Photo X2 give users exceptional control over some of the most critical imaging adjustments. The Curves dialog box includes a histogram, so photographers can easily and intuitively fine-tune their work. Three automatic settings let less-experienced users optimize the contrast and color levels in their images with a few clicks.

- **Histogram Adjustment** — With Paint Shop Pro Photo X2, the Histogram Adjustment feature lets users display the tonal range of an image and fine-tune the balance of shadows, midtones, and highlights. More advanced users can use this feature to manually correct exposure.

- **Adjustment Layers** — Whenever a tonal or color change is applied to an image, the image’s information is altered, which means that the image ultimately starts to degrade. The advantage of using adjustment layers is that they do not permanently modify the image layers themselves. Advanced users love working with adjustment layers in Paint Shop Pro Photo X2 because they offer a great way to adjust the color or tone of underlying layers without actually modifying the pixels of those layers. In addition, users can add multiple adjustment layers to test various color corrections or to see how several corrections look when they’re combined.

Lens Distortion Correction Filters: Paint Shop Pro Photo X2 provides excellent Lens Distortion Correction filters that help users correct common photo distortions, such as fish-eye, barrel, and pincushion.

Users can easily correct distorted images with Lens Distortion Correction filters.
Create One-Of-A-Kind Photos

Paint Shop Pro Photo X2 offers an array of graphics tools and creative effects that help users transform their photos into one-of-a-kind artistic images. While professional-strength image-correction tools have always been at the core of the application, Paint Shop Pro Photo is also renowned for letting users push their artistic boundaries. Whether making a photo look like it was taken long ago with a bygone era’s film and camera technology, or adding stunning artistic effects, users of Paint Shop Pro Photo X2 can unleash their creativity.

**New! Layer Styles:** This feature lets users apply a variety of artistic effects to a layer, such as Drop Shadow, Emboss, and Reflection, without having to leave the Layer Properties dialog box.

Layer Styles lets users easily apply artistic effects to their images.

---

**Give it a try**

**Using Layer Styles**

1. First, create a graphic by clicking **File ➤ New**.

2. On the Tools toolbar, choose the **Text** tool, type **X2**, and click **Apply**.

3. On the Layers palette, double-click the layer containing the text.

4. In the Layer Properties dialog box, click the **Layer Styles** tab.

5. Mark any of the following check boxes:
   - **Reflection** — creates a reflection of the selected layer
   - **Outer Glow** — applies an outer glow around the selected layer
   - **Bevel** — applies a bevelled edge around the selected layer
   - **Emboss** — gives the selected layer an embossed look
   - **Inner Glow** — applies an inner glow within the selected layer
Film and Filters: Paint Shop Pro Photo X2 offers users a range of effects inspired by classic film and filter types. Users can experiment with a variety of film-effect and filter-effect combinations to produce interesting, eye-catching results. Users can also simulate the effect of using color filters on the lens of a camera by applying a Creative Filter effect, or they can apply a Film Look to simulate the effect of using different types of film in a traditional camera.

Time Machine: The Time Machine offers users a tour of photographic history by letting them see what their photos would look like if they had been taken in another era. With a range of settings based on photo styles from the 1830s to the 1980s, users can easily send their photos back in time. A live preview lets users see the evolution of photography on a single image.

Warp Brush: The Warp Brush lets users easily create caricatures of their photos or photo subjects by distorting the pixels in a particular area of the photo.

Effects Browser: The Effects Browser lets users preview an enormous range of effects before applying them to an image.

Vector Drawing Tools: Using the Text tool, users can add descriptive or decorative text to an image, and the text can be easily edited and formatted.

Using the Preset Shapes tool, users can add predefined shapes — such as callouts, arrows, flowers, and gears — to images. The range of predefined shapes has been expanded in Paint Shop Pro Photo X2.

Enhanced! Picture Tubes™: A longtime user favorite, the Picture Tube tool lets users paint on their photos with a collection of professionally designed artistic elements. For example, users can add butterflies and beetles to a picnic setting, fill an aquarium with fish, or frame a picture with holly. Picture Tubes™ are available in a variety of themes, and users can also create their own graphics to use with the Picture Tube tool. Paint Shop Pro Photo X2 has several new Picture Tubes, giving users more options when enhancing their photos.

Enhanced! Picture Frames and Photo Edges: Using picture frames and photo edges, users can easily add eye-catching final touches to their images. Paint Shop Pro Photo X2 provides a variety of picture frame styles, and the frames are editable, so users can tweak them or create their own. The addition

Give it a try

- **Drop Shadow** — applies a drop shadow to the selected layer

  Mark the **Layer** check box to show the layer data with the effects applied. When unmarked, this check box lets you turn off the layer data and just show the effects.

  6 Drag the **Opacity** and **Size** sliders, and choose a color to fine-tune the layer effects.

  7 Click **OK**.
of new picture frames and photo edges in Paint Shop Pro Photo X2 offers users even more creative possibilities.
Summary of New and Improved Features

- **The Express Lab** lets users quickly fix all the photos in a folder without having to open each one. With advanced tools and one-click fixes, users don’t sacrifice editing power for speed.

- **Two new modes for the Makeover Tool** let users improve how the subjects in their photos look. The **Thinify** mode helps people lose those pounds the camera sometimes adds, and the **Eye Drop** mode takes the red out of bloodshot eyes.

- **HDR Photo Merge** helps users make the most of their camera’s auto-bracket feature, allowing them to merge photos with different exposure levels to create an image that retains every critical detail of the photos being combined. This feature includes an integrated **Clarify control** that applies automatic dodging and burning, so images keep their “snap.”

- **Improved Black and White Film effect** lets users create black-and-white photos by simulating the effects of shooting black-and-white film with colored filters. Users can now select from a virtually infinite range of color combinations. This feature also now includes an integrated Clarify control.

- The **improved Save As command** helps users quickly choose the file formats they use most often.

- **The Auto-Preserve Originals** feature ensures that users never have to worry about overwriting their original photos by automatically creating a backup copy one level down in the folder hierarchy of their computers.

- **The Save for Office** feature optimizes images for their intended use, ensuring that there are no file size, performance, or printing problems.

- **The Crop to New Image** feature is a great time-saver when extracting individual images from a group scan.

- With **improved camera raw support**, users who shoot in raw formats can choose from an expanded list of supported cameras.

- **Visible Watermarks** let users add a discreet mark to their photos to remind viewers who took the shot.

- **Dynamic Language Switching** lets users easily change the language they’re working in.

- **Improved Layer Styles** lets users easily experiment with and preview popular image effects.
What’s Included in Corel® Paint Shop Pro® Photo X2?

Applications

- **Corel® Paint Shop Pro® Photo X2**: Based on user feedback, Corel Paint Shop Pro Photo X2 is a complete digital photography toolkit, offering easy-to-use, professional-quality image-editing tools and features.

- **Getting Started with Corel Paint Shop Pro Photo X2**: Video tutorials on CD, a $49 value, from lynda.com, a leading provider of training materials for renowned software products. (English only)

- **Corel® MediaOne™ Plus**: This $39 fully functional product is available free to Paint Shop Pro Photo customers via a special download. It provides everything users need to create unique multimedia shows, including transitions, background music, and motion effects. (This version does not include the ability to author DVDs with slideshows, and will be available for download beginning September 22, 2007.)

Content

Corel Paint Shop Pro Photo X2 provides hundreds of high-quality, easy-to-use creative extras, including the following:

- **Picture Tubes™**: Click and paint with photos and creative pictures.
- **Picture Frames**: Easily add decorations and borders.
- **Photo Edges**: Apply a unique shape or a torn-edges look.
- **Patterns**: Paint with sophisticated colors and unique combinations; make your own backgrounds or scrapbook paper.
- **Textures**: Paint with any color, and then use a texture to add depth.

Bonus Content

- **Nik™ plug-in filter effects**: From the recognized leader in digital photographic filters, these plug-ins offer features and functionality that are designed to make digital photographic enhancements and digital photography not only easier, but better. (English, German, French, and Spanish only)

- **Zazzle®**: $25 coupon for online photo processing (U.S. and Canada only)
• **Imagekind™ prints:** $25 coupon for high-quality prints and poster art (U.S. and Canada only)

• **SnapTotes® bag:** $25 coupon for leather bag with custom photo imprint (U.S. and Canada only)

• **Carbonite® backup service:** Free trial of this fully automatic Internet backup service (U.S. and Canada only)

### Printed Documentation

• **Corel Paint Shop Pro Photo X2 User Guide:** An updated 144-page user guide describes common photo-correction and image-enhancement workflows. The printed user guide mirrors the workflow outlined in the Learning Center to help users quickly master the application.

### Electronic Documentation

• **Help file:** Users can easily access information on specific features and common tasks with a comprehensive index and full-text search. Users can also click links in dialog boxes and the Learning Center to get context-sensitive help when they need it.

• **Learning Center palette:** The award-winning Learning Center was designed to ensure that anyone can harness the power of advanced photo editing, regardless of their previous software experience. It builds user confidence by helping them complete tasks within seconds of launching Paint Shop Pro Photo, resulting in higher levels of satisfaction and enjoyment from the software.

• **PDF version of the Corel Paint Shop Pro Photo X2 Help**

### Minimum System Requirements

• 1 GHz processor

• Windows Vista™ or Windows® XP, with latest service packs installed

• Microsoft® DirectX® 9.0c or higher (included with Windows XP and Windows Vista)

• Internet Explorer® 6 or higher (included with Windows XP and Windows Vista)

• 256 MB of RAM (768 MB for Windows Vista)

• 500 MB of free hard disk space

• 1024 × 768 resolution display, 24-bit color display

### Recommended System Configuration

• 2-GHz processor or faster

• 768 MB of RAM

### Additional Requirements for Selected Features

• Microsoft® Outlook®, Outlook® Express, WordPerfect® MAIL™, or other MAPI-compliant e-mail software (to e-mail from the product)
Customer Support and Other Resources

Corel Corporation provides a multitiered offering of support options for its business and graphics applications, designed to accommodate consumer, small business, and corporate customers. Additional information about global availability of our support services is located on the Corel web site at www.corel.com/support.

Free Support
Available 24 hours a day, 7 days a week, every day of the year, the Corel® Knowledge Base™ provides free and unlimited support for all registered users of Corel’s retail and licensed software. This searchable Web-based tool provides answers to commonly asked technical questions. Responses are searchable in English, French, German, Italian, Spanish, Portuguese, and Japanese. To search the Corel Knowledge Base, please visit: www.corel.com/knowledgebase.

Personal Telephone Support
Many customers choose to speak directly to a Corel support technician over the telephone. Live person-to-person support is provided on a toll-free line and is designed for individual, small business, academic, trial version, and OEM users.

A support incident is the resolution of one technical question, problem, or issue, regardless of the number of telephone calls required to resolve it, and includes assistance with understanding how features work and how they are applied to a sample document (you are shown how the feature works, but not how to implement the feature within your file), troubleshooting technical issues and documents, installation, configuration, and setup (standalone), and migration from one version to another.

Enterprise Level Support
This enhanced level of support is designed for corporate clients who require account management services and access to Corel’s most skilled support...
personnel. This option is typically selected by organizations that employ dedicated support professionals, have centralized technical management, or require specialized support. Corel's experienced support team of specialists deliver high-quality support and provide the resources necessary to maintain a mission-critical environment. Needs for your entire enterprise are addressed from integration issues, open document management API (ODMA), network configuration, thin-client platforms, large-scale network application rollouts and in-house developer requirements.

**Professional Services**

The Corel Professional Services team builds solutions for international market leaders in government and Fortune 1000 organizations, including aerospace, defense, manufacturing, utilities, retail, and financial services. The team's expertise resides in deploying new technology solutions, software deployment, application automation and third-party integration support, solution sets, and training.

**Partnership Program**

Designed with maximum flexibility to meet the needs of diverse range of partners, the Corel® Partner Program offers unparalleled tools and support, including the ultimate information resource, Corel® Connected.

**Zoom-In Newsletter**

A must-have for digital camera owners, this free monthly newsletter provides tutorials, quick tips, links to free content downloads, and user profiles that illustrate how people just like you are using Corel digital imaging software to create and share their photos. (U.S. and Canada only)
About Corel

Corel is a leading developer of graphics, productivity, and digital media software, with more than 100 million users worldwide. The company's product portfolio includes some of the world's most popular and widely recognized software brands, including CorelDRAW® Graphics Suite, Corel® Paint Shop Pro®, Corel® Painter™, Corel DESIGNER®, Corel® WordPerfect® Office, WinZip®, and iGrafx®. In 2006, Corel acquired InterVideo, makers of WinDVD®, and Ulead, a leading developer of video, imaging, and DVD authoring software. Designed to help people become more productive and express their creative potential, Corel's full-featured software products set a higher standard for value in being easier to learn and use. The industry has responded with hundreds of awards recognizing Corel's leadership in software innovation, design, and value. Corel's products are sold in more than 75 countries through a well-established network of international resellers, retailers, original equipment manufacturers, online providers, and Corel's global Web sites. With its headquarters in Ottawa, Canada, the company has major offices in the United States, the United Kingdom, Germany, China, and Japan. Corel's stock is traded on the NASDAQ under the symbol CREL and on the TSX under the symbol CRE.